Programmer/debugger les controleurs ARM avec Eclipse et GCC

Introduction

Le présent document explique comment, pas par pas, configurer et utiliser un IDE de classe

professionnelle totalement gratuit. L'exemple simple montre comment compiler et debugger un

programme avec Eclipse, GCC (GNU Compiler Collection) et OpenOCD sur une cible ARM (LPC2103

de NXP).

Une chaine non « propriétaire » et non limitée :

- en taille de code,

- en optimisations,

- en temps,

- convenant a tous les processeurs ARM supportés par GCC (arm7, arm9 et variantes), de toutes
marques (NXP, Atmel, STR,...).

Comme matériel, j'ai utilisé une carte de développement LPC2103 bon marché, avec une sonde
JTAGkey tiny de Amontec ( http://www.amontec.com/jtagkey-tiny.shtml ). Pour ceux qui souhaient
encore réduire le codt et qui ont un PC avec un port paralléle, construire un « Wiggler » tel que
celui ci : http://wiki.jelectronigue.com/projets/wiggler_clone/wiggler_clone

La description suivante est basée sur les denieres versions d'Eclipse (3.3, version 2007-fall2
« Europa »), d'OpenOCD (r247 — 30/12/2007) et de GCC (4.2.2)/GDB (6.7.1 du 31/12/2007).
Une des difficultés, I'écriture d'un makefile, est évitée.

En préalable, s'assurer que le PC est bien équipé d'un runtime « Java » de version supérieure a
1.5.0 (ce qui est le cas de la grande majorité des PC récents). Ceci peut se Vvérifier en tapant
Jjava -version dans une fenétre DOS. Sinon, le télécharger de http://www.java.com/fr .

Il faudra également télécharger et installer sur le PC les « GNU CoreUtils », qui interprétent les
commandes des shell Linux sous Windows :

http://gnuwin32.sourceforge.net/packages/coreutils.htm ou bien

http://sourceforge.net/projects/gnuwin32

Remarque générale : J'ai personnellement tout installé dans un répertoire qui s'appelle D:\arm.
Dans les explications qui suivent, il faudra donc préciser le répertoire utilisateur approprié.

Installation de I'IDE Eclipse

L'installation de la chaine de développement nécessite d'installer :

— L'IDE eclipse; qui devra étre complété par « CDT » (C Developpement Toolkit) et par « Zylin
embedded CDT » (appelés « plugins »).

- Le compilateur GCC pour ARM (arm-elf-gcc)

Se connecter a http://www.eclipse.org , y télécharger « Eclipse IDE for C/C++ developpers » :
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Le fichier qui sera téléchargé s'appelle : eclipse-cpp-europa-fall2-win32.zip

L'installation est simple : Ce zip contient un répertoire eclipse qu'il il suffit de décompresser a un
endroit approprié.

L'étape suivante consiste maintenant a installer CDT et Zylin Embedded CDT.

Il y a d'autres méthodes que celle que je vais décrire, mais j'ai eu des problemes d'incompatibilité
entre versions; celle-ci évite ces ennuis.

Il faut lancer éclipse, simplement en cliquant sur « eclipse.exe »
II proposera d'abord un « workspace », c'est le dossier de travail. Cliquer « OK » si celui qui est
proposé convient, sinon choisir un autre.

Voila I'écran d'accueil ; cliquer « goto the workbench »
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Et voici comment cela se présente :
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Cette vue, telle qu'elle apparait a I'écran s'appelle une « Perspective ».
Ici, il s'agit de la « Perspective » « C/C++ »

Aller directement dans le menu : Help ->Software Update -> Find and Install ; sur I'écran qui
apprait, choisir : « Search for new features to install »

Je ne vais pas décrire la suite des es manipulations en détail, la maniére de procéder est
parfaitement décrite ici :

http://subclipse.tigris.org/install.html (Ne pas installer subclipse, c'est simplement pour la maniere
de procéder)

Les URL des « new remote sites » desquels CDT et Zylin CDT seront téléchargés sont les suivants:
Pour CDT, le site est http://download.eclipse.org/tools/cdt/releases/europa

Pour Zylin embedded CDT, le site est http://www.zylin.com/zylincdt

Comme « name », on peut mettre ce que l'on veut (par exemple CDT et ZylinCDT)

Sélectionner les updates trouvés, accepter les licences, et « OK » pour les menus.

Installer I'un et puis l'autre, eclipse se redémarrera apres chaque installation.

Apres ces deux installations, Eclipse est configuré.

Installation de la chaine GCC/GNU :

Elle est disponible gratuitement ici :

http://www.yagarto.de/index.html




@ ° - Q" ﬁj 1 http:f/woww.yagarto.defindex. html | | |a¥- o _ B X
[ | YAGARTO - Yet another GHU AR... [ | YAGARTO - Yet another GHU... 3 T

— —

Open On-Chip Debugger (2.66 MB)

( md5sum:
a40385bd1329%bafa1c9d3ed5daffb659 )
r247 30.12.2007
This version of OpenOCD supports the
following

JTAG Interfaces.

YAGARTO Tools (700 KB)

( md5sum:
a1c654d6704bd3c1e109a73ce22eece2a )

Include tools like make, sh, touch and more. | 20070303 03.03.2007

You only need these tools if you do not
have

installed the Open On-Chip Debugger,

and want to use J-Link / SAM-ICE.

YAGARTO GNU ARM toolchain (31 MB)

(md5 Binutils-2.17
maosum. Newlib-1.15.0
684147abad4875680ed2cc0093d70b961 ) GCC-4.2.1 17.11.2007
Can be used for Insight and Eclipse Insight-6.5.50
debugging.
YAGARTO GNU ARM toolchain (29 MB)
( md5sum:
ab19617ffb4dc8a913402caffb7e4fb7 )
This version does not support Insight. Blnut.lls-2.18
Newlib-1.16.0
For 31.12.2007
debugging your application you must GCC-4.2.2
use GDB-6.7.1

Eclipse. But this version is

Télécharger « YAGARTO GNU ARM toolchain »

Le fichier téléchargé d'appelle :
yagarto-bu-2.18_ gcc-4.2.2-c-c++_nl-1.16.0_gdb-6.7.1_20071231.exe

De méme, télécharger « Open On-Chip Debugger » (OpenOCD), version 30.12.2007
Le fichier téléchargé d'appelle : openocd-r247-20071230.exe

Cette version est utilise directement GDB. Il n'est plus nécessaire d'utiliser Insight.

Exécuter ces fichiers afin de les installer dans le répertoire adéquat. Vérifier que le cmpilateur est
fonctionnel : dans une fenétre DOS, taper arm-elf-gcc -v . Il répondra par les option disponnibles
et la version.

Si la carte d'essai ARM possede un jumper de sélection RUN/DEBUG, ne pas oublier de positionner

celui-ci sur « DEBUG »




Le premier programme

Lancer Eclipse,
1ére étape importante : aller dans le menu : Window -> Preferences.. cliquer sur « New CDT

project Wizzard » déselectionner le « Show projects types and toolchains only if they are
supported on the plattform » , puis cliquer sur « Cygwin GCC » et « Make toolchain preferred »

= Preferences = @

|bype filter text New CDT project wizard i
& General [
B C/C++ Settings will be applied to COT new project wizard during project creation process
: Appearance
* Build Console Preferred toolchains | Wizard defaults
- CDT build variables )
Code Style Project types: Toalchain:
] De.bug [ @e || B cygwin Goc |
£ Ed|t.or (= Shared Library Linux GCC
. E_nwronment - @ Static Library MchSX GCC
Fhe: TP ~© Executable (XL €/C++) :“TG‘_*"’ EES
i m—— ) € static Library(XL C/C++) XE g,rl’lg++ Tool Chain
¢ Language Mappings -4y Shared Library (XL C/C++) |
. = Make

#-(= Makefile project
@ Makefile Editor
I Wew CDT project wizard
-~ Makefile Project
Property Pages settings

- Task Tags l: 1L
Template Default Values Preferred toolchain will be selected by default in Wizard
] Lo Lampicr l Make toolchain(s) preferred ]
~ Embedded CDT
- Help l Make toolchain(s) not preferred J
g Istolflipdate [ show project types and toolchains only if they are supported on the platform
#- Run/Debug
- Team
[Restore gefaultsl l Apply ]
(7) ’ OK l I Cancel J

Le premier projet :
Aller dans le menu : File -> New -> C project
Dans le wizzard, taper le nom souhaité : /edblink ; puis comme précédemment : déselectionner le

« Show projects and toolchains only if they are supported on the plattform » , puis cliquer sur
« Cygwin GCC »
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Cliquer sur « Finish » L'écran se présente alors comme ceci :

Un warning, mais ce n'est pas grave, il suffit de décocher l'option « Build Automatically » dans le
menu « Project »
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II faut maintenant ajouter les sources C :
Cliguer sur le nom du projet (ledblink), puis par un clic sur le bouton droit de la souris dans le
menu contextel : Import -> File system

< Import = ”_ID EE

Select
E\A q
Import resources from the local file system into an existing project.

Select an import source:
|type filter text |

== General
: 5, Archive File
g2 Breakpoints
1 Existing P

jects into Workspace

------ =l Preferences

®-E= CfC++
®-E= CVS
®-= Team




Sélectionner ensuite (Next) le dossier ou est décompressé I'exemple joint a cet article :
Choisir les fichiers / Folders a importer; I'écran se présente alors comme ceci :

= Import

File system
Import resources from the local file system.
-

From directory: l_D:'\temp |‘V] [ Browse... ]

= [E] = temp
“[¥] 2= build
[£] ledswitch.c
[£] lpcz10x_gnuarm.h
[Filter Iypes...” gelect All ” Deselect All ]

Browse. ..

Into folder: Ig_d_};ll_ini(

Options

] Overwrite existing resources without warning
() Create complete folder structure

(3) Create selected folders only

7 e Einish ] [ Cancel

Cliquer sur « Finish », Eclipse se présente alors comme suit, (aprés avoir double-cliqué sur
« ledswitch.c », pour faire apparaitre le code) :
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2 5= ledblink % o8 |pc210x_gnuarm.h
& (= build _ . S i - # LEDPIN
& [h] Ipc210x_gnuarm.h [ @ ° ledInit{void) : void
& [ ledswitch.c | . @ ® delay(void) : void
1 g1 X s A NIy, 4 - @ main(void) : int
B crtd.zip
#include "lpc2lOx gnuarm.hn”
// BRSE2103 2106: 1led on PO.23 (active low)
#define LEDPIN 23
static void ledInit(veoid)
GPIC IODIR [= (1<<LEDPIN):;
GPIC IOCSET = (1<<LEDFPIN): 14
(i I |
I_‘f_ Problems | ¥ Tasks | & Console 2 £ Properties|© Progress Ce =0
No consoles to display at this time.
i Writable Smart Insert | 1:1

Attention, toute modification effectuée dans la fenétre centrale (édition) doit étre suivie d'un save

sinon, elle n'est pas prise en compte. Ne pas oublier donc d'effectuer cette opération avant toute
compilation (« Build »).

Commence alors une délicate étape de configuration, mais elle n'est répétée qu'une seule fois (par

projet) et permet d'éviter |'écriture d'un Makefile assez complexe, qui sera généré
automatiquement : cliquer sur le nom du projet, puis par un clic sur le bouton droit de la souris

dans le menu contextuel : Properties
Cliquer sur le menu C/C++ build :

1. Cliguer maintenant sur « Settings » de C/C++ build, dans l'onglet « tools settings »
II faut modifier les invocations de I'assembleur, du compilteur et du linker :

Modifier l'invocation de I'assembler « as »
par «arm-elf-gcc -mcpu=arm7tdmi »
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< Properties for ledblink = ﬁ
[type filter text Settings =T
-~ Resource ™
- Builders . =l
=5 C,fc++ Build Configuration: |DE‘hU9 |VJ [Manage configurations|
Discovery options  The configuration support is not installed on the system
Envirenment —_— B _
Settings &5 Tool settings | & Build steps | " Build artifact | [as Binary parsers| @ Error parsers
- Tool chain editor S =5 —
. Variahles =) GCC Assembler Command: | arm-elf-gee -mepu=armztdmi
PO m : - : =
XL CfC++ Compiler P %} g Genecrallj ; All options: | -q3 -x assembler-with-cpp A
- G/ C++ General ¥ i);gwm Enpies 3
~{#2 Preprocessor
-~ Project References ; % St
i Refactoring History %" s
: : (& Directories
- Run/Debug Settings W
(2 Optimization _
-8 Debugging Expert settings:
(2 Warnings Command o, nAND) ${FLAGS} ${OUTPUT_FL|
Lo e pattapyy Lt ey
; (22 Miscellaneous 4
=] @} Cygwin C Linker
-2 General
@ Libraries
(% Miscellaneous
"% Shared Library Setting; (]
<] | 2]
@ [ OK ] [ Cancel J

Dans le menu « General » juste en dessous de « GCC assembler, rajouter come « Assembler
Flags » : -g3 -x assembler-with-cpp Ce Flag apparaitra en grisé dans la fenétre « All Options »

de l'assembler

< Properties for ledblink
type fiter text Settings
- Resource |
- Builders + |
= C,"C++ Build Configuration: |Dehug |VJ [Manage configurations
i Discovery options & The configuration support is not installed on the system
Ervironment —_— = .
Settings i Tool settings |,-‘°‘ Build steps | Build artifact || [& Binary parsers i| @ Error parsers
- Tool chain editor : = -
L variables =53 GCC Assembler Assembler flags | -g3 - assembler-with-cpp
¢ L2 General —
XL Cf/C++ Compiler i g
=) Include paths (-I =
& CJC++ General - @} (i)rgwm C Compiler : pi I
(2 Preprocessor
- Project References ; m SiLpl
- Refactoring History f’f‘ Lleds
i : (2 Directories
- Run/Debug Settings | e R
2 Optimization
- (# Debugging
2 warnings
© o (# Miscellaneous [ suppress warnings (-W) B
= @3 Cygwin C Linker ] announce version (-v)
-~ (2 General
@ Libraries
- Miscellaneous
(2 Shared Library Setting; [ |
[ | @l
)] OK ] I Cancel J
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2. De la méme maniéere, Cygwin C compiler toujours de I'onglet « Tools settings » Command :

XL C/C++ Compiler

=] i ;
- Cf/C++ General = (E;'g;'ﬂﬂ C Compiler rchsd
- Project References i l%; reprocessor
l (2% Symbaols

Refactoring History

- Run/Debug Settings i iredones

(B pptimization
(2 Debugging
-2 Warnings
-2 Miscellaneous
= B3 Cygwin C Linker
- General
(B Ubraries
(2 Miscellaneous
- Shared Library Setting;

| Expert settings:
| Command

: ${COMMAND} ${FLAGS} ${0OUTPUT_FL
line pattern: = e

= Properties for ledblink =] X
|type filter text | Settings =
: Re.source ' |
_ i;giirsgu”d Configuration; DEl:ILIg V Manage cnnﬁguratinnsé
i Discovery options & The configuration support is not installed on the system
Er;;:-,?gsment & Tool settings | A Build steps | Build artifact | s Binary parsers |8 Error El_arsers_i
: I:SilaET:;n wlilen =8 G1CC Assembler |Command: | prm-elf-gee -mepu=armztdmi
-3 General |All options: | -0 -g3 -Wall -c -fmessage-

Modifier I'invocation du compilateur par arm-elf-gcc -mcpu=arm7tdmi
3. La configuration du Linker : essentiellement trois choses :
- Modifier l'invocation

- Préciser le script : ici LPC2103-RAM.Id .
Pour un exécutable en Flash, on choisira LPC2103-ROM.Id. Ces scripts sont facilement

modifiables en fonction du processeur : simplement changer la taille de la Flash et de la Ram.

- Ajouter la routine de bas niveau « crt0.0 » : Cette routine est celle qui est donnée dans
I'exemple joint (crt0.S) en zip, que j'ai compilée en ligne de commande dos. J'ai essayé
d'utiliser (sans succes) celles fournies dans la distribution GCC. J'ai donc opté pour cette
solution.

L'invocation du linker : arm-elf-gcc
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"= Properties for ledblink

|type filter text
- Resource
- Builders
r' C,fc++ Build
i Discovery options
- Environment
Settings
i Tool chain editor
- Variables
KL CfC++ Compiler
& C/C++ General
. Project References
Refactoring History
" Run/Debug Settings

Settings

Configuration: | Debug

i i l ’ Manage configurations l

% The configuration support is not installed on the system

& Tool settings | #: Build steps| |

Build artifact || o4 Binary parsers i| @ Error parsersi

@ GCC Assembler
(2 General
|'_, @} Cygwin C Compiler
(% Preprocessor
@ Symbols
(2 Directories
(2 Optimization
(% Debugaing
(8 warnings
2 Miscellaneous
=] @} Cygwin C Linker
(% General
@ Libraries
- (2 Miscellaneous
- (# shared Library Setting:

Command: | arm-elf-gec
-nostartfiles -nodefaultlibs -nostdlib -static -
L"D:farm/yagarto/arm-elf/lib" -T
_./build/LPC2103-RAM.Id

All options:

Expert settings:

Command |, . 1
line pattern: L ¥.COMMAND} S{FLAGS} ${OUTPUT_FLAG}${OUTP|

OK

/|

Cancel

Dans menu « General », spécifier les options comme suit :

‘= Properties for ledblink

|type filter text
- Resource
- Builders
E: CJ"C++ Build
Discovery options
Environment
Settings
Tool chain editor
" variables
‘- XL CfC++ Compiler
& CfC++ General
- Project References
Refactoring History
- Run/Debug Settings

Settings

Configuration: | Debug

i VJ ’ Manage configurations

& The configuration support is not installed on the system

% Tool settings | # Build steps |

Build artifact || [ Binary parsers il @ Error parsers|

-

=83 GCC Assembler
(25 General

@3 Cygwin C Compiler
~(#2 Preprocessor
@ Symbols

(% Directories
—(# Optimization

. (Z Debugging
(2 Warnings
(%8 Miscellaneous

& Miscellaneous

LB Shared Library Setting:

Do not use standard start files (-nostartfiles)
Do not use default libraries (-nodefaultlibs)
Mo startup or default libs (-nostdlib)

] ©mit all symbeal infermation (-s)

Mo shared libraries (-static)

I

Cancel

Dans le menu « Librairies » (j'ai installé Yagarto dans le folder « D:\arm — modifier le cas échéant)
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|type filter text |

-~ Resource

. Builders

EJ C)‘C++ Build

. Discovery options
- Envirenment

- Setfings

- Tool chain editor
Variables

FaXL C/C++ Compiler
& C}‘C++ General

- Project References
-- Refactoring History
- Run/Debug Settings

Settings

Configuration: |Debug

| [manage configurations|

& The configuration support is not installed on the system

B Tool settings | # Build steps

[‘E’ Build artifact || Binary parsers || & Error pa._rsers|

B &-} GCC Assembler

(% General

= @u Cygwin C Compiler
(% Preprocessor

-~ (# gymbols

(% Directories

- optimization

- (# Debugging

- (2 Warnings

(& Miscellaneous

= B3 Cygwin C Linker

(2 General

- (# Miscellaneous

(2 Shared Library Setting:

Libraries (-1}

€ & §#

Library search path (-L)

€ e = §§

@

ok || cance

Le menu « Miscellaneous »

|type filter text |

- Resource
Builders
= C/C++ Build

- Discovery options
" Environment
- Toaol chain editar
Varighles
XL CfC++ Compiler
& CfC++ General
Project References
- Refactaring History
Run/Debug Settings

Settings

Configuration: | Debug

| [ Manage configurations|

/& The configuration support is not installed on the system

& Tool settings | # Build steps | ' Build artifact| s Binary parsers | @ Error parsers|

=8 E-} GCC Assembler
-~ General

= @} Cygwin C Compiler
L @ Preprocessaor
(2 Symbols

----- 2 Directories

----- 2 Optimization
(2 Debugging

----- (2 Warnings
— (2 Miscellaneous
5@} Cygwin C Linker

Linker flags |

Other options (-Xlinker [option]) = ow B 9l 3

Other objects

aa 85 b

o ]
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Rajouter -T ../build/LPC2103-RAM.Id dans « Linker Flags ».

Si c'est pour générer un exécutable en FLASH, spécifier LPC2103-ROM.Id

A l'aide des boutons :

a8

rajouter ../crt0.0 dans « Other Objects »

il

Le « ../ » s'explique du fait que le makefile est exécuté a partir de « Debug ».

Attention, YAGARTO a certaines reminescences Linux : Dans certains cas, mettre « \ » (Folder

Windows) a la place de « / » (Folder Linux) provoquera une erreur (file not found).

Dans l'onglet « Build steps » rajouter la commande « cp ledblink.elf D:/arm/tmp/a.elf » et
un commentaire approprié comme « Description »qui servira a copier notre exécutable ledblink.elf
vers un répertoire temporaire (ici, j'ai pris D:/arm/tmp) pour la programmation flash.

2 Properties for ledblink

type filter text

- Resource
- Builders
= CfC++ Build
i Discovery options
-~ Environment
Settings
. Tool chain editor
Variables
XL C/C++ Compiler
- C/C++ General
- Project References
' Refactoring History
- Run/Debug Settings

Settings

Configuration: _De_I?H_g_

 The configuration support is not installed on the system

% Tool settings| A Build steps |

Pre-build steps
Command:

Description:

Post-build steps
Command:

cp ledblink.elf D:/arm/tmp/a.elf
Description:

Copy elf vers tmp

Build artifact | [n4 Binary parsers| @ Error parsers|

]

:V | | Manage configurations
™

DK l [ Cancel

Dans l'onglet suivant «Build artifact », remplacer I'Artifact extension (.exe), qui peut poser des

problémes, par .elf :
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= Properties for ledblink

ib,rpe filter text |
- Resource

- Builders

= CfCH++ Build

~ Discovery options

- Environment

- Settings

i~ Tool chain editor

Variables

- XL C/C++ Compiler

& CfC++ General

Project References

Refactoring History

Run/Debug Settings

@

Settings
|&
Configuration: |Debug M ’Mana_ge c:_mﬁgu;_’at[ons]
| & The configuration support is not installed on the system 1
| & Tool Settjngs" - Build steps |! Binary parsers || & Error parsersi
Artifact Type: I Executable |V] =
Artifact name: : ledblink |
Artifact extension: irelf |
Output prefix: | ' |
l.i_l
ok J[ Concel |

Finalement, I'écran « Binary parsers » doit ressembler a ceci » (cocher les options appropriées):

= C/C++ Build
- Discavery options
- Environment
- Settings
- Tool chain editor
Variables
- XL C/C++ Compiler
#- CfC++ General
Project References
Refactoring History
Run/Debug Settings

| () The configuration support is not installed on the system

| i3 Tool setting.s" # Build steps || 10 puild a:tifact] Binary parsers [Q Error parsersi

Binary parser:

= Properties for ledblink B[=)
bpefiterted | | settings -
-~ Resource
.. Builders
Configuration:  Debud Wiahage tanl

Cyqwin PE Parser
Elf Parser
GNU EIf Parser

[1 mach-0 Parser
M WE-iY SNk Parcar

E

&

@

| ok

I

Cancel

J

Cliquer sur « OK » pour fermer I|'écran, le projet est alors prét a étre compilé. La création d'un
exécutable s'appelle un « build ».
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Dans I'écran principal, aller dans le menu « Project » puis « Clean.. », s'assurer que l'option « start
a build immediately » est bien coché puis « OK ».

Apres avoir cliqué sur « OK », 'écran se présente comme ceci :

= C/C++ - ledblink/ledswitch.c - Eclipse Platform =JoEd
File Edit Refactor Mavigate Search Project Run Window Help
e TR =l -l C /K-~  HB-O-Q- @ - | @ oo+ |
5 : o - 4% Debug
[T Project Explarer 52 = O | [¢ ledswitch.c 2 = 8% outline 5 (@ Make Target| = O
=) =0 BEste
(=] | -l Ipc210x_gnuarm.h
®-%%. Binaries ¥ A - # LEDPIN
(= build o7 |edinitivoid) : void
=-(= Debug /7 8% delay(void) : void
- @ %5 ledblink.elf - [arm/le] FITEL L LT A TEL L LT TE LR T LT L L LS L LI L LSS L LT L i | - ® main({void) : int
. @-|o ledswitch.o - [arm/le]
H -2 ledswitch.d #include "lpc2lOx gnuarm.h”
i L@ makefile e | i o .
: @ Ubjects.mk / BRAOEZ1L :-_i__"';: ied on FuU.Z3 (active 10wW)
#define LEDPIN 23
; -|@ sources.mk
L@ subdir.mk static void ledInit (void)
& [h Ipc210x% gnuarm.h :
- lg ledswitch.c GPIC IODIR |= (1<<LEDPIN):
i [ﬂ{u crid.o GPIO_IOSET = (1<<LEDPIN):
“E] erto.zip ¥
static void delay (void)
volatile int i,3; | s |
liea] I | 2]
[Z: Problems v Tasks | Bl Console 2 [ Properties| & Progress| @B 00
C-Build [ledblink] __ - - - - - ]
arm-elf-gcc —nostartfiles —nodefauwltlibs -nostdlib —static -L"D:/arm/vagarto/arm-elf/1ib"™ -T ||
.« /build/LPCZ103-RAM.1d —o"ledblink.elf” ./ledswitch.o ../crtd.o
Finished building target: ledblink.elf
cs-make --no-print-directory post-build =
Copy elf vers tmp (1|
cp ledblink.elf D:/arm/tmp/a.elf [
e 5= ledblink

On peut constater que les différents « makefile » (et .mk) ont été rajoutés automatiquement (dans
un nouveau folder « Debug »).
Un fichier exécutable « .elf » est présent.

L'étape suivante est l'intégration d'OpenOCD dans Eclipse
Cette manip n'est pas stritement indispensable (On peut aussi démarrer OpenOcd dans une

fenétre de commande DOS), mais l'installation telle que je vais la décrire apporte beaucoup de
confort d'utilisation.

Tout d'abord, pour installer un « server » OpenOcd :

Aller dans le menu « Run » -> « External Tools » -> « Open External Tools Dialog ». Ce qui
apparait ressemble a ceci :
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< External Tools

Run a program

L - —+l. .
L1 -l E =i

Create, manage, and run configurations

=+l

type filter text

@k

Filter matched 1 of 1 items

Configure launch settings from this dialog:

| - Press the 'Mew' button to create a configuration of the selected type.

|= - Press the 'Duplicate’ button to copy the selected configuration.

# - Press the 'Delete’ button to remove the selected configuration.
—*l
5

o - Press the 'Filter' button to configure filtering options.

- Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the Ferspectives preference

I3

Cliquer une (ou deux fois) sur « Program », il apparaitra
de remplir de la maniére suivante :

une « New_configuration » qu'il convient

= External Tools

Create, manage, and run configurations

Run a program

= i
0 =

5T

type fiter text
= @ Program
-, Mew_configuration

Filter matched 2 of 2 items

Name: | OpenOCD

=] main ¥ Refresh | BE Environment| = Common |
Location:

D:varmiopenocd-r247\bin'lpcnocd-ftd 2300 exe

’Ercvwse Works_gace...] EBrowsg File S',rstem...g [ ‘I.l’ari_ables... l

Working Directory:

’Brcmrse Worl_(space...] [Elrowse File System...] [ Variables... l

Arguments:

-f D:\armiopenocd-r247\bin\lpc2xoo_jtagkey.cfg T

Mote: Enclose an argument containing spaces using double-quotes ().

[ Apply J [ Revert ]

@

[ J[ cow ]
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Clest a dire :

Dans « Name », taper « OpenOCD » (la New_confihuration prendra ce nom apreés clic sur
« apply))

Dans « Location », taper le chemin de I'exécutable OpenOCD

Dans « Arguments », introduire -f et le nom avec le chemin du fichier de configuration
d'OpenOCD » (ici Ipc2xxx_jtagkey.cfg), qui dépend de la sonde (Jtag ou Wiggler) utilisée.

Notes :
J'ai presonnellement installé la chaine GCC/OpenOCD dans mon répertoire D:\arm Il conviendra
de préciser celui qui est adéquat.
1. J'utilise une sonde Jtag USB (avec FTDI232), il faudra choisir I'exécutable et le fichier de
configuration qui convient (différents si Wiggler sur port parall€le)
2. Ma carte ARM est a base de LPC2103. Il faudra également choisir I'exécutable et le fichier
de configuration (.cfg) approprié.

Cliquer alors sur « Apply » puis « Close »

Répéter |'opération pour créer un « External Tools » qui programme la Flash (toujours avec
OpenOCD) :

= External Tools

Create, manage, and run configurations @
i
Run a program e
sl
g R — _-:'.'5 hd

- Name: | FlashProgrammer
type filter text

Qr =] Main " Refrash | I Environment| = Common |
= rogram " i : =
-, FlashProgrammer Loomren:
-3, Open0OCD D:\arm\openocd-r247\bin\lpcnocd-ftd2woc exe
\Eruwse Wnrksgace...] [Elrowsg File Syatem...] [ Variables... ]

Warking Directory:
D:\armiopenocd-r2474bin',

[Bruwse Wnrl_cspace...] [Erowse File System...] [ Variables...

Arguments:

-f Di\armiopenocd-r247\bin'|pc2ioc:_jtagkey_flash.cfg

Mote: Enclose an argument containing spaces using double-quotes ("),

| Filter matched 3 of 3 items

19



C'est apparemment le méme que le précédent, sauf que il fait appel a un fichier de configuration
différent : Ipc2xxx_jtagkey flash.cfg

Ce fichier est similaire au précédent (Ipc2xxx_jtagkey.cfg) sauf :

— qu'il fait appel a un script qui programme le « a.elf » qui se trouve dans D:\arm\tmp
— qu'il coupe le serveur (shutdown) aprés I'opération

Il contient la ligne supplémentaire :

target_script 0 reset D:/arm/openocd-r247/bin/flash.script

« flash.script » est un fichier qui contient les commandes OpenOCD suivantes

arm7_ 9 dcc_downloads enable

wait halt
sleep 10
poll

flash probe 0

# erase first bank only:

flash erase 0 0 O

# erase all banks: #26 secteurs pour LPC2138; 8 pour LPC2103
# flash erase 0 0 26

flash auto erase on
flash write_image D:/arm/tmp/a.elf 0x0 elf

# flash write is deprecated but still available.
# Update to flash write binary 0 a.bin 0x0
reset run

sleep 10

shutdown

Retourner maintenant dans le menu « « Run » -> « External Tools » « Organize Favorites »; dans
la fenétre qui s'ouvre, cliquer « Add », puis dans la nouvelle fenetre qui s'ouvre, sélectionner
OpenOcd et FlashProgrammer :

-

< Add External Tools Fa...

Select Launch Configurations:
L FlashProgrammer:
[¥] &4, Open0OCD
[ Select All ” Deselect All ]
@) [ oK l ’ Cancel l

Cliquer sur « OK » (2 fois).
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Femer et relancer Eclipse : OpenOCD et « FlashProgrammer » appraissent alors directement dans
le menu « Run » -> « External Tools »

Il faut maintenant configurer OpenOCD et GDB

Il faut d'abord préparer deux fichiers, qui serviront de fichiers de commandes d'initialisation de
GDB :

Un premier, que I'on pourra appeler gdbinit_ram : contenant

target remote localhost:3333
monitor reset

monitor sleep 500

monitor poll

monitor soft reset halt
monitor arm7 9 sw _bkpts enable
load

br main

continue

Un second, qui servira a debugger des programmes en Flash, que I'on pourra nommer
gdbinit_rom, contenant :

target remote localhost:3333

monitor reset

monitor sleep 500

monitor poll

monitor soft reset halt

monitor arm7 9 force hw bkpts enable

Ce qui appelle quelques commentaires :

target remote localhost:3333 indique a GDB qu'il doit communiquer avec OpenOCD via le port local
3333.

Les lignes suivantes qui commencent par « monitor » sont des commandes OpenOCD qui lui sont
envoyées par GDB

load : charge le programme en RAM
br main : met un « breakpoint dans a la fonction main »
continue : commence |'exécution

Ces deux fichiers seront placés dans un répertoire approprité (D:\arm\tmp dans mon cas).
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Dans le menu principal « Run » ou en cliquant sur la petite fleche (vers le bas) a coté de l'insecte

vert, on choisit « Open debug dialog », puis en déroulant (cliquant sur ) « Zylin Embedded debug
(Native) », il y a une configuration «ledblink debug ».

B Debug

Create, manage, and run configurations

i : Mame: | ledblink Dehug
sty tug

=, (B Main e IZJ*:etrL.tgger-'i @ Commands| B, Source| = Q:rmmon-:_
-] C/C++ Attach to Local Applica || | = =i = i i

- [£] ¢/C++ Local Application ‘ _
[€] C/C++ Postmortem debugger | ETOJeCt:

- [£] GDB Hardware Debugging ledblink '
- &G Zylin Embedded debug {Cygwi || |

| C/C++ Application:
¢ Zylin Embedded debug (MNative || |

.. 2¢ ledblink Debug Dehu_g\ledhlink.elf | [Searcﬂ Pruject...l [ Browse... J

[ Application console

Il{ ! [T} | !}|

Filter matched 7 of 7 items

7 Debug ] [ Close

Debug en RAM :

Il faut maintenant configurer le Debugger , dans I'onglet approprié:
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< Debug

Create, manage, and run configurations

s

x ._ _%_;,-

; Mame: | ledblink Debu_g
| |type filter text

==, E] Main ?;S Debugge:f B Commands B Source | gnmmoﬁ
[t | C/C++ Aftach to Local Applicatior || | - ! .

- [g] C/C++ Local Application Debugger:
|e]| C/C++ Postmortem debugger

- [£] GDB Hardware Debugging Dehu.g_ger Options

5 Zylin Embedded debug (Cygwin) Main

iz Zylin Embedded debug (Native)

2 Jedbik BeBla] 08 debugger: arm-elf-gd
GDB command file: D:/arm/tmp/gdbinit_ram

(Warning: Some commands in this file may interfere with the startup
operation of the debugger, for example "run".

GDB command set: | Standard ".

Protocol: [ mi v & |

[Jverbose console mode ‘

< ; il | | >.|
. Filter matched 7 of 7 items

(7 Debug l [ Close

Le debugger s'appelle arm-elf-gdb.

Remplacer le « GDB command files » proposé par défaut par le fichier créé précédemment (avec

le chemin complet — attention / et pas \ ) : gdbinit_ram .

GDB est maintenant configuré : cliquer sur « Close »

Aller dans le menu « Windows » -> « Open Perspective » -> « Debug »

Maintenant :

— Brancher la sonde JTAG (en supposant, si c'est une sonde USB, que les drivers auront été
installés au préalable)

— Mettre la carte d'essai ARM sous tension

Effectuer un RESET de celle-ci (en appuyant sur le bouton approprié)

Lancer OpenOCD : aller dans le menu « Run » -> « External Tools » -> « OpenOCD »

Voici ce qui apparait dans la console :
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Info: openocd.c:93 main(): Open On-Chip Debugger (2007-12-30 17:00 CET) svn
247

Info: openocd.c:94 main(): S$URL:
http://svn.berlios.de/svnroot/repos/openocd/trunk/src/openocd.c $
Info: jtag.c:1291 jtag examine chain(): JTAG device found: O0x4fl1fO0fO0f

(Manufacturer: 0x787, Part: Oxflf0, Version: 0x4)

Warning: arm7 9 common.c:742 arm7 9 assert reset(): srst resets test logic, too

OpenOCD a bien trouvé la sonde JTAG. Si échec, ré-appuyer sur le bouton reset de la carte ARM

et recommencer.

Retourner dans le menu « Run » -> « Open Debug Dialog » et cliquer maintenant sur le bouton
« Debug », afin de lancer GDB

Voici ce qui apparait ensuite dans la « Console » (c'est GDB qui effectue le chargement du
programme en RAM) :

source D:/arm/tmp/gdbinit ram

0x0000014c in 2?2 ()

target state: running

requesting target halt and executing a soft reset
software breakpoints enabled

Loading section .text, size 0x214 1lma 0x40000000

Start address 0x40000050, load size 532

Transfer rate: 16 KB/sec, 532 bytes/write.

Breakpoint 2 at 0x400001a0: file ../ledswitch.c, line 32.

Breakpoint 2, main () at ../ledswitch.c:32
32 MAM MAMCR = 2; // MAM functions fully enabled (?)

La suite releve de I'utilisation du debugger GDB. Il est par exemple possible de mettre un

« Breakpoint » en positionnant la souris devant une ligne C et en cliquant avec le bouton droit,
dans le menu contextuel « toggle breakpoint », exécuter pas par pas, examiner (et modifier) les
registres, les variables, la mémoire, I'asm, ... avec les différents boutons ou méme d'introduire
directement des commandes GDB dans la « console ». La sonde JTAG réagit instantanément.
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< Debug - ledblink/ledswitch.c - Eclipse Platform Q@
File Edit Refactor Mavigate Search Run Project Window Help
i e i R P L e e 5 | %5 Debug | "
iﬁ? Debug B Fo e = T = i = = [ |[t9= Variables | % Breakpoints |42 Registers &2 =i Modules = 0O
=] Cﬁ, OpenOCD [Program] s
p| D:larm\openocd-r247\bin\lpcnocd-ftd2oc exe I\.l.ame Value ;",\"i_
=-5G ledblink Debug [Zylin Embedded debug (Native)] | = B Main 3l
(=] Embedded GDB (4/01/08 12:58) (Suspended) e a |
. =-a® Thread [0] (Suspended: Breakpoint hit.) e ort 0
) =11 main() C:\Documents _ar'ld-SemngS\mé:Ty\wwkspaqe\Eedbtinmeds'wlmh.c:{iUxi w2 8388608
w| arm-elf-gdb (4/01/08 12:58) 3 3758260236 .
1010 ATNANETING ;Vl.
sl | £ .
| 2] ledswitch.c &2 = i EE Outline | [m} Disassembly 52 ; =)
ledInit(); iA:_ | 0x400001dc <main+84>: mov T2, $5388608 ; 0x80000|s |
0%400001e0 <main+88>: str 12, [r3]
i=0; delay ()
while (1) _:390}(.400001&4 <main+92>: bl Ox40000120 <delay>
[ GPIO TOSET=({1<<LEDPIN):; // set all outputs in
| GPIO IOCLR=(1<<LEDFIN}:; // set all tpute in mask to O 0x400001e8 <mein+96>: mov r3, #-536870908 ; 0OxeDD0O
3,; delay(): 0x400001ec <main+100>: add T3, T3, #163840 ; 0x28000
| GPIC IOSET=(1<<LEDPIN): // set all outputs in mask to 1 0x400001f0 <main+104>: mov T2, #B8388608 ; 0x80000___
| v delay(); 0x400001f4 <main+l108>: str T2, [r3]
| 44 = | delayi); |
1 LA |l @0x400001£8 <main+1123: bl  Ox40000120 <delay>
el ]
%] [l ] | 2]
| El console i3 4 Tasks| [2: Problems| ] '2;’*_'. EULE A Bl o T 0
|ledblink Debug [Zylin Embedded debug (Native]] arm-elf-gdb (4/01/08 12:58) |
[ (i)
Ereakpolnt 1, main () at ../ledswitch.c:32
132 MAM MAMCR = 2; // MAM functions fully enabled (7?) =
]
B

Les différentes fenétres s'appellent des Vues « Views ». Il est possible d'en ajouter (ou enlever) via
le menu « Window » - « Show View ». On peut également les redimentionner (agrandir), et

finalement, arranger I'écran comme I'on veut.

Pour arréter le debug, cliquer sur «ledblink debug » puis, avec le menu qui apparait avec un clic

du bouton droit : « Terminate and remove ».

Pour repasser a I'écran C du compilateur, aller dans le menu « Window --> Open Perspective ->
C/C++. Si, par mégarde, on ferme une ou plusieurs fenetres de la « Perspective », toujours dans
le méme menu Window, effectuer : « Reset Perspective ».

25



Debug d'un programme en Flash :

Ne pas oublier de changer le script du linker avant de faire le build
L'étape supplémentaire consiste a flasher d'abord le uC :
Une fois le buid effecté, aller dans le menu : « Run » - « External Tools » « FlashProgrammer »

Ceci apparait dans la « console » :

Info: openocd.c:93 main () : Open On-Chip Debugger (2007-12-30 17:00 CET) svn:
247

Info: openocd.c:94 main(): SURL:
http://svn.berlios.de/svnroot/repos/openocd/trunk/src/openocd.c $

Info: jtag.c:1291 jtag examine chain(): JTAG device found: O0x4flf0fO0f
(Manufacturer: 0x787, Part: 0xflf0, Version: 0x4)

Warning: arm7_ 9 common.c:742 arm7_ 9 assert reset(): srst resets test logic, too

La programmation flash n'apparait pas explicitement.
Switcher vers la Perspective Debug (Windows -> Open Perspective —> Debug)

On voit le flash programmer qui est dans la fenétre Debug. Cliquer sur celui-ci avec le bouton droit
de le souris et dans le menu contextuel : « Terminate and Remove ».

Il faut effectuer cette opération avant de relancer OpenOCD (sinon, il mettra un message d'erreur
comme quoi on ne peut pas utiliser deux sondes en méme temps)

Comme précédemment, lancer maintenant le serveur OpenOCD : aller dans le menu « Run » ->
« External Tools » -> « OpenOCD »

Ouvrir le menu « Run » -> « Open Debug Dialog », et dans I'onglet Debugger, changer
gdbinit_ram par gdbinit_rom

Une fois que cela est fait : cliquer sur le bouton « Debug » , GDB se lance. Tout est OK :

Voir la copie d'écran ci-aprés : le programme est bien en Flash (adresses 0x0000.....).
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= Debug - ledblink/ledswitch.c - Eclipse Platform eS|

Eile Edit Refactor MNavigate Search Project Run Window Help

e iG-S ; (Che B | %5 Debug | ?
%fﬁ Debug 5 Sl ] T T 7 | i = = O ||t= variable | % Breakpo | i} Register = = Modules| = O |
=43, OpenOCD [Program] =

: w| D:\armiopenocd-r247\bin\lpcnocd-frd 2o exe Harmie Value Taell
=-5¢ ledblink Debug [Zylin Embedded debug (Native)] = S Main =il
= Embedded GDB (5/01/08 23:19) (Suspended) e g 0
=g Thread [0] (Suspended: Breakpoint hit.) 1oy 0
5 = i1 main() C:\Documents and Settings\thierry\workspace\ledblink\ledswitch.c:42 0x0000 woe 1o 1000
p arm-elf-gdb (5/01/08 23:19) 1w g 1 .
it r4 4294967295 M|
& | [
<] ; | [l
[£] ledswitch.c 52 = O || 5= outline | [ai} Disassembly 52 =0|
i=0; B while (1) ||
while (1) {
{ GPIC_IOCLR=(1<<LEDFIN); // set all out]
% GPIC IOCLR=|1<<LEDFIN); // set a1l outputs in mask to iM0x000001dec <main+76>: mov 3, #-536870900 ; 1
delay(): 0x000001el <main+ add r3, r3, #163840 ; |
GEIC IOSET=(1<<LEDPIN); // set all outputs in mask to 0x000001e4 <mail mov r2, #8388608
delay|(): 0x000001e8 <main+ str 2, [r3]
it4: delay(}:
} 5 0x000001ec <main+92>: bl 0x120 <delay>
3 GFIC_IO 1<<LEDFIN);: // set all out]
return 0; 0xD00001£0 <main+96>: mov r3, ¥-536870908 ; |
1 i.v 0x000001f4 «<main+i00>: add =3, 384(
2] | i <' ) ETE—
| & Console 2 ) Tasks| [Z Problems| ] Sx BH|
|OpenDCD [Program] D:\arm\openocd-r247\bin\ipcnocd-fid2wotexe
|Warning: gdb server.c:270 gdb get packet(): acknowled ived,; but no packet pending EA_
e Lo

Derniéres remarques et conclusion

Tout ceci a I'air bien compliqué, mais avec un peu d'habitude, cela devient simple et évident.
Il doit étre possible aussi de créer des projets « template », afin d'éviter toutes les étapes de
configuration.

- Eclipse est écrit en Java, donc son exécution est assez lente. Il faut donc un PC puissant; pas
la peine d'essayer avec un Pentium 2 a 400MHz.

- Tout ce que j'ai décrit ci-dessus est parfaitement réalisable sous Linux. Télécharger les versions
appropriées.

- Ily a d'autres programmes inclus dans la distribution GCC :

- arm-elf-objcopy : permet de convertir les exécutables en différents formats (Bin, Hex, S19
par exemple).

- arm-elf-objdump : dump des symboles des objets, désassemblage, ..

- etc.

— La plupart des manipulations via les menus que j'ai décrites sont accessibles via des icones
d'eclipse (par exemple le switch entre perspectives, le lancement du debug,..). Il faut
cependant une certaine habitude, mais c'est nettement plus rapide.

- L'utilisation de arm-elf-gcc sans eclipse est parfaitement possible sous DOS, en ligne de
commande et avec un éditeur standard pour les fichiers source.

27



- Eclipse peut étre utilisé (simultanément) avec tout autre microcontréleur supporté par GCC.
J'utilise Eclipse/GCC (m68k-elf-gcc) simultanément pour des projets ColdFire (Freescale). II
suffira « juste » de paramétrer adéquatement le projet (et éventuellement utilser un
« workspace » différent).

Pour approfondir GCC/GDB, beaucoup de docs sont librement téléchargeables sur internet :
http://www.gnu.org/manual

Pour comprendre le développement en C sous GCC, une compréhention basique de MAKE est utile.

Finalement, les pages précédentes résultent de longues semaines de galéere et de recherche. Sans
tutorial clair, Eclipse n'est pas simple ni intuitif, avec de trés nombreux menus tout aussi tortueux
les uns que les autres, mais il faut avouer que réussir a debugger son premier programme avec
GDB rend aussi euphorique que le premier clignottement de led.

Liens ARM -GCC -OpenOCD, ou I'on pourra par exemple trouver modes d'emploi, différents fichiers
de configurations OpenOCD pour différents ARM (LPC, ATMEL, STR7,..) ainsi que des projets
exemples :

ttp://www.yagarto.de/ : Chaine GCC/GDB

httD //openfacts berllos de/lndex-en Dhtml?tltle ODen+On Chip+Debugger OpenOCD
: : ARM projects by Martin Thomas:

accessmg ARM controllers with OpenOCD.
http://wiki.jelectronique.com/at91/openocd : utilsation OpenOCD avec AT91 et Wiggler (francais)

thierry
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